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 WORKSHOP DESCRIPTION 

Overview 
Through this workshop you will learn about the different elements needed in a word document 
to make it accessible to a diverse audience.  Creating an accessible base document through 
Microsoft word will allow you to convert to accessible PDF and HTML document formats as 
well. We will go over the essential structural elements needed in an accessible document such as 
heading styles, ordered and unordered lists, and headers and footers.  We will also explain how to 
add non-text elements, images, tables and hyperlinks to your document so that they are 
accessible.  Lastly, we will go over how to convert your base document across formats such as 
PDF and HTML. 

Prerequisites 
Individuals taking this workshop should have basic computer skills, knowledge about the 
creation of  documents using a word processor such as MS Word, and the ability to work in the 
Windows or Macintosh OS environments. 

Objectives 
▪ To learn about the different structural and design elements needed in an accessible 

word document. 
▪ To understand how to include these elements when creating a document. 
▪ To apply what you have learned about accessible word documents to create an 

accessible document.  
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 CREATING ACCESSIBLE WORD DOCUMENTS 

Introduction 
 
The focus of  this workshop is to create documents that are accessible to individuals with a 
visual impairment and that require the use of  an assistive technology, like a screen reader, to 
navigate and read documents.  Nevertheless, you should also think about other characteristics 
your audience members may have (physical disability, learning disability, learning style, language, 
etc.) and design documents that meet those needs.  Although we will not cover every aspect or 
user characteristic, we hope that through the suggestions provided you will have a better starting 
point for creating accessible documents.  

Some Formatting Basics 
 
Before we get into the details of  using Styles to structure a document, let’s go over some general 
formatting elements:  
 

▪ Layout of  Content – Divide content into manageable blocks of  text to make it easier 
for users to navigate document. For example, include headings, sub-headings to 
divide text into related paragraphs and sections. Use bulleted or numbered lists to 
display lists instead of  using lengthy sentences. 
 

▪ Language Used – Be aware of  your audience and their specific needs.  Use language 
that is appropriate to your target audience.  Also, if  you are using abbreviations or 
acronyms make sure to provide the full/expanded definition the first time you use 
them in a document.  These can be placed in parenthesis next to the abbreviation or 
acronym. Do not assume your audience knows what a particular term means, define 
terms that may be unclear to your reader.     
 

▪ Font Type:  Choose sans-serif  fonts like Arial, Tahoma, Trebuchet MS, Verdana and 
Helvetica which are easier to read in comparison to serif  fonts like Times New 
Roman or Courier.  For a full discussion and list of  recommended fonts see 
WebAIM’s Fonts Article (http://www.webaim.org/techniques/fonts/). 
 

▪ Text Color – Some users cannot perceive certain colors (green and red).  Therefore 
do not rely on color to bring out text in a document, instead use a style that 
underlines or bolds the text.  

 
▪ Contrast – Use a high contrast between text and background colors.  Use dark text 

on light backgrounds and light text on dark backgrounds. 
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Structure Your Document  
 
One of  the most important elements in creating an accessible word document is to organize and 
structure your document using markup also known as tagging.  Markup allows you to define the 
status of  specific portions of  text throughout your document.  Through markup you define 
whether the text is a header, a heading 1, a heading 2, a paragraph, a column, an ordered or 
unordered list, or any other element type.   
 
This is important for individuals using a screen reader, because it allows the screen reader to 
detect the type of  text it is reading from the markup you have used to create your document.  
Using markup is also beneficial for the sighted user because it keeps your document in an 
organized and clear structure that is easier to read.     
 
To markup a document, use the Styles tool in MS Word.  You can use a built in style, modify an 
existing style or create your own style. Do not use direct character or paragraph formatting, such 
as when you select text in your document and click on B to bold or I to italicize.  This will only 
format individual letters, words and groups of  words and not define what element they 
represent in a document (a title, a heading, a list, etc.). 
 
 Using styles allows you to create an organized structure in your document by defining text 
throughout the document (i.e. a title is distinguished from a heading, from a subheading, from a 
paragraph, etc).  Another advantage of  using Styles is that the structure and organization of  
your base document is maintained across formats, it is easier to read by all users including 
individuals using assistive technologies, because elements are easier to detect.   
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Using Styles 
 
In order to structure your document through markup you must use the Styles and Formatting 
function under the Format Menu in Microsoft Word.  You can also access Styles in Word from 
the Style drop down tool on the Formatting Toolbar.  However, this Style drop down menu is 
used to apply styles to selected text in your document and displays what style is currently being 
used in the document based on your current location in the document.  You cannot modify 
and/or create styles from this tool.  Therefore to Modify an existing style or create a new style 
you must open the Styles and Formatting task pane from the Format menu or click on the Styles 
and Formatting Icon on the formatting toolbar. 
 

 
 
 

You can access Styles in Word from the 
Format menu, the Styles drop down tool, or 
the Styles & Formatting shortcut on the 
toolbar. 
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When you open the Styles and Formatting task pane you will see different preformatted styles.  
For a new blank document the default list of  styles shown includes three heading styles called 
Heading 1, Heading 2, and Heading 3 and a paragraph style called Normal, there are however 
more styles you can choose from.  To view all preformatted styles select All Styles from the drop 
down menu at the bottom of  the Styles and Formatting task pane.   
 
 
 
 

Notice to the right 
of  each Style name 
an icon that defines 
the style type 

This text box tells 
you what style is 
currently selected in 
your document 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select All Styles from this 
drop down menu to view 
preformatted paragraph, 
character, list and table styles 
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Modifying a Style 
You may modify an existing style or create your own custom style.  To modify an existing style 
follow these steps: 

 
step 1. From the Styles and Formatting task pane choose one of  the preformatted styles you 

would like to modify. 
step 2. On the right of  the Style’s name, click on the drop down arrow and select Modify.  

This will open the Modify Style dialog box. 
step 3. Provide a name for your style based on the type of  text you will be applying it to. 
step 4. Select the style for the following paragraph from the drop down list (usually this will 

be normal). 
step 5. Change the font type, font size, line spacing, add a border, etc. from the Formatting 

section. 
step 6. Once you have made your changes to the style, click OK to save your changes.   
step 7. To apply your style to text in your document simply select the text and click on the 

name of  your style from the Styles and Formatting task pane. 
 
 
 Make changes to the 

selected style:  add a 
new title and 
formatting options 
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Define the 
properties and 
formatting for your 
new style. 

The Preview 
window allows you 
to see your style as 
you create it. 

Creating a New Style 
If  existing preformatted styles do not meet your needs you can create a custom style that you 
can then apply to your selected document text.  To create a new style follow these steps: 
 

step 1. Select the New Style button from the Styles and Formatting task pane which will 
open the New Style dialog box. 

step 2. You will see two sections:  Properties and Formatting. 
step 3. From the Properties section you will define the style name, the type of  style:  

paragraph, character, table or list (choose based on the type of  text you will be 
applying the style to). 

step 4. From the Formatting section select the font type, font size, alignment and other 
formatting options. 

step 5. Click OK to save you new style. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

 

 

TIP : Avoid using direct formatting from the formatting toolbar to format text 
in your document because it only performs character formatting and does not 
create a labeled style.  



Creating a Style for Ordered and Unordered Lists 
There are two ways you can create ordered and unordered lists and customize a list type in your 
document.  The first option is to create them by accessing the Format menu and selecting the 
Bullets and Numbering option.   
 

step 1. Navigate to the Menu Bar and click on Format 
step 2. From the drop down menu select Bullets and Numbering, a new window labeled 

Bullets and Numbering window will appear 
step 3. Select the bullet style you want from the preformatted list styles:  bulleted, 

numbered, outline numbered or list styles 
step 4. Once you have applied the list style it will appear listed along with other styles on the 

Style and Formatting task pane. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You can also add an existing list style, modify an existing style or create your own custom list 
style specific to your needs, from the Styles and Formatting pane. 
 

step 1. Select New Style from the Styles and Formatting pane. 
step 2. From the Style Type drop down menu select List. 
step 3. Define the characteristics of  your style including:  name, font type and size, bulleted 

or numbered, etc.  
step 4. View created style within the preview box and make changes as necessary 
step 5. Click OK to add New Style to list of  styles. 
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Select List
Style type drop 
down. 

 from the 

Select either 
bulleted or 
numbered list 
here 

You can select more 
options from the 
Format button

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

TIP : If  you will be exporting the document to html format use regular bullets, 
special bullets would not be recognized by html because it would require users to 
have access to a special font set. 

Headers and Footers 
In addition to using paragraph styles in your documents to organize and define the structure of  
a document, elements such as page numbers, notes and citations should be placed within a 
header and/or footer.  These should not be done manually, for example typing out the number 
1, 2, 3 etc. at the top or bottom of  every page as page numbers, because they will not be 
included within the marked up structure of  the document. To add a header and/or footer to a 
document select Header and Footer from the View Menu. 



Working with Images 
Besides text, most documents also include images.  Some of  the most common images used 
within documents are: 
 

▪ Descriptive or Informative images 
▪ Decorative images such as icons or logos 
▪ Charts to represent information from a data table 

 
The overall purpose of  including images in any document should be to help the reader 
comprehend the purpose and/or meaning of  the content they are reading.  Thus, it is important 
that if  you are including images in a document that all individuals understand their purpose. 
 
There are two fundamental procedures you should follow when including images in your 
documents in order to ensure that images are accessible to your audience:   
 

1. Use the Insert function in Word to add images to your document, do not copy and 
paste images. 

2. Add an alternative text description, also known as Alt-text.  These alternative text 
descriptions should not repeat what is already stated in captions within the 
document or other document text.   

 
The following are the basic steps to include accessible images in your documents: 
 

step 1. Navigate to the Menu Bar and click on Insert. 
step 2. From the Insert drop down menu select Picture, a sub-menu will appear with various 

options. 
step 3. Choose the option depending on where the image is located, usually you will be 

selecting From File to locate the image on your computer or other storage media.   
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Type in alternative 
text description here. 

Once the image is inserted, add an alternative text description. ted, add an alternative text description. 
  

step 4. You can either click on the image to select it and from the Format menu click on 
Picture, double click on the image to open the Format Picture window, or right click 
on the image and select Format Picture. 

step 4. You can either click on the image to select it and from the Format menu click on 
Picture, double click on the image to open the Format Picture window, or right click 
on the image and select Format Picture. 

step 5. On the Format Picture window, select the Web tab. step 5. On the Format Picture window, select the Web tab. 
step 6. In the text box provided, type in a description for the image and click OK. step 6. In the text box provided, type in a description for the image and click OK. 
step 7. Your image is now ready with an alt-text description that will be carried over to other 

formats of  your document such as PDF and HTML. 
step 7. Your image is now ready with an alt-text description that will be carried over to other 

formats of  your document such as PDF and HTML. 
  

 

 

 

TIP : Word on Macintosh does not provide the Alt text option. Use Word on 
Windows to add alt text descriptions to images.  Or you can use the use the Insert 
Caption option in Macintosh to add a description above or below an image.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 

 

 

TIP : Before inserting images into your document, edit them and resize them as 
necessary using a picture editing software such as Adobe Photoshop or Paint.  

 



Tables 
In addition to images and charts, you may also add Tables in your document to organize 
information or to display data.  The following are some guidelines when creating tables in Word: 
 

▪ Create Tables from the Table Menu and select either Insert Table or Draw Table 
▪ Use Heading Styles for row and column headings 
▪ If  the table continues on to another page make sure you repeat the table header on 

the new page (turn on “Repeat As Header Row at the Top of  Each Page”) 
▪ Turn off  “Allow Row to Break Across Pages” option under the Table Properties 
▪ Keep table simple, do not nest tables or merge cells.  Simple data tables have one 

row of  headings or one column of  headings or both.   
 
It is important to note that assistive technology such as screen readers, read tables in a linear 
form.  For example, the screen reader begins reading from the first row of  the table and then 
progresses left to right across the columns. When the row ends, it continues to the start of  the 
second row and so forth. Also, screen readers assume that the first row and column of  a table 
contain heading information.  In order for assistive technology to recognize which cells are the 
headers in a table, these have to be marked with tags in PDF or HTML.  
 
 Use heading 

styles for row 
and column 
headings. 
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Hyperlinks 
Hyperlinks are elements within electronic documents that link to another section in the 
document or to another electronic document such as a webpage, another word document, a 
presentation, a spreadsheet, etc.   
 
When placing hyperlinks in a document you should provide a text description that will become 
the active link to the website or other document.  Listing the URL to a website 
(http://www.csus.edu) as a link, is not sufficient.  Instead, a descriptive text label (i.e. Sac State 
Website) is required.  These descriptive labels should not be ambiguous such as “Click Here” or 
“Click,” they should be descriptive, to help the reader understand where the link is going to take 
them to. 
 
You can display the URL to website at the side of  a descriptive text label for a link such as: 
Accessibility at Sac State Website (http://www.csus.edu/accessibility/).  However, if  the URL is 
too long and confusing avoid listing it in your document.  Also, if  including multiple links in a 
document, separate these by using non-linked characters in between or by placing them in a 
bulleted list.  This will help screen readers detect multiple links.   
 
To create a hyperlink do the following: 
 

step 1. Highlight the text that describes the electronic document you want to link to 
step 2. From the Format Menu select Hyperlink, the Edit Hyperlink window will open 
step 3. Within the Text to display, text box, you will see the text you highlighted in your 

document 
step 4. Select the location of  the electronic document you want to link to (within document, 

a web page, another file, e-mail address) 
step 5. Type in the URL of  the document you want to link to in the text box labeled 

Address, and click OK 
step 6. In Microsoft Word by default, hyperlinks will be in blue and underlined  
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Bookmarks and Table of Contents 
If  you are creating long documents make sure you include both bookmarks and a table of  
contents.  Bookmarks allow users to move through the content of  your document, it is best to 
add bookmarks to all of  the major sections of  your document. 
 

▪ You can access both Bookmarks 
and Table of  Contents from the 
Insert Menu and by selecting 
Index and Tables or Bookmarks.  

▪ Limit the hierarchy to 3 levels of  
heading in a Table of  Contents  

▪ Update the table of  contents to 
reflect changes made either in 
the organization of  content or 
changes to content. 
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Other Accessibility Issues 
We have talked about many structural and design elements that you can implement in your 
documents to make them accessible.  However, file size and access to specific software 
applications like Microsoft Office are other important issues related to accessibility.   

File Size 
Users who do not have a high speed internet connection such as DSL may find it difficult to 
download files from a specific website, an online course management system like WebCT, and 
their email.  Thus, it is important that when you make documents available to users 
electronically, that these documents are not too large that would impede users without access to 
high speed internet connections from downloading them.  You can reduce the file size of  your 
documents by following some basic tips: 
 

▪ Before adding images to a document resize and edit images using an image editor 
like Adobe Photoshop or Paint. 

▪ Break up large documents into smaller documents if  possible. 
▪ Convert word documents into other formats such as Adobe PDF or HTML. 

Access to Software 
There are still many users that may not have access to specific software from their home 
computers, thus they may not be able to download files that use specific software such as MS 
Office applications.  One suggestion is to add a link to the different MS Office application 
viewers such as Word Viewer.  You can also provide an html version of  your document, which 
only requires users to have access to an internet browser. 
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Converting your Base Document to PDF 
In order for your document to be converted into a tagged PDF document your must use the 
Adobe Acrobat Plug In to convert your document.  Using the Adobe Acrobat Plug-In 
automates the process of  creating Tags to your PDF document.  The Print to PDF option 
creates an untagged PDF document, therefore if  you use this option you will have to add tags 
within Adobe Acrobat and if  changes are made to the base document and converted to PDF, 
you must redo all of  the tags.  To begin the process of  converting your word document into 
PDF format follow these directions: 
 

1. Check the Adobe Acrobat PDF Maker Settings 
2. There are four tabs within the Adobe Acrobat PDF Maker Settings you must check:  

Settings, Security, Word and Bookmark tabs. 
3. Save your word document before converting to Adobe PDF format.  

 
To convert your document to PDF select Convert to Adobe PDF from the Adobe PDF menu 
or use the shortcut button on the PDF maker toolbar. 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

TIP : PDF accessibility is not fully supported using PDF Maker on Macintosh.  
Use Windows to convert your documents into PDF format.   
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Converting your Base Document to HTML 
One advantage of  converting your word documents in HTML format is that you provide users 
who do not have access to specific software applications like MS Office, the ability to access and 
download your documents.  Also, if  you have included structural elements such as heading 
styles, alternative text descriptions to your document (as explained throughout this document) 
these elements are transferred into the HTML format of  your document.  There are two 
options available when converting your document to HTML format: 
 

1. Save as Web Page 
2. Save as Web Page, Filtered 

 
We recommend that if  you are to convert your document(s) into HTML format, that you save 
as a filtered webpage because this format maintains most of  the original document’s appearance 
and it is smaller in size because it does not add on extra HTML as the Save as Web Page option.  
Therefore we will focus on explaining how to save a word document as a filtered web page 
below. 

Filtered Webpage 
The process of  saving a word document into HTML format is very similar to saving as a word 
document format.   

 
step 1. When you are ready to save your document, navigate to the File menu and select 

Save As. 
step 2. The Save As window will open.  From the Save as type drop down menu select Web 

Page, Filtered. 
step 3. Provide your document a name and click Save.   
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Conclusion 
Creating accessible base documents, such as word documents is essential in developing 
accessible documents across various formats such as PDF and HTML.  We have covered the 
basic structural elements needed in an accessible document which include:  heading styles, 
correctly inserting ordered and unordered lists, headers and footers, hyperlinks, tables and 
images.  We have also looked at how to add alternative text descriptions to non-text elements 
such as images, which allow audience members using assistive technology such as screen readers, 
to read your documents correctly.  Lastly, we covered how to convert word documents into PDF 
and HTML formats, which will retain the structural elements that have been included in the base 
document.  
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RESOURCES 

Alternate Formats 
For questions regarding provision of  instructional materials in alternate formats for students 
with visual impairments, learning disabilities, or mobility impairments that impact their ability to 
read printed materials, please contact the Services to Students with Disabilities' High Tech 
Center at (916)278-7915/htc@csus.edu..   
 
 The High-Tech Center Website  
  http://www.csus.edu/sswd/services/htc.html 

Faculty / Staff Resource Center  
Located in ARC 3012. Assistance available on walk-in basis. 
Open Lab on Fridays, 1-4 pm (Fall, Winter, Spring) 
Open Lab on Thursdays 1-4 pm (Summer only)  
FSRC Website 
 http://www.csus.edu/uccs/fscenter/ 

Getting Help 
 University Help Desk 
  (916) 278-7337 or helpdesk@csus.edu  
 Academic Technology Consultants 
  http://www.csus.edu/atcs/contact.htm  
 Help Desk - Problem Reports & Contact Information 
  http://www.csus.edu/uccs/helpdesk/contact.stm 
 Training Requests 
  training@csus.edu 

Campus Resources 
 Training 
  http://www.csus.edu/training 
 Training Handouts 
  http://www.csus.edu/training/handouts 
 Online Tutorials 
  http://www.csus.edu/atcs/tools/tutorials.htm 
 Educational Tools 
  http://www.csus.edu/atcs/tools 
 Creating Instructional Materials 
  http://www.csus.edu/atcs/tools/accessible/ 
 Accessibility at Sacramento State 
  http://www.csus.edu/accessibility 

 Academic Technology and Creative Services : 2008  MS Word : Creating Accessible Word Documents   20 

mailto:htc@csus.edu
http://www.csus.edu/sswd/services/htc.html
http://www.csus.edu/sswd/services/htc.html
http://www.csus.edu/uccs/fscenter/
mailto:helpdesk@csus.edu
http://www.csus.edu/atcs/contact.htm
http://www.csus.edu/uccs/helpdesk/contact.stm
mailto:training@csus.edu
http://www.csus.edu/training/
http://www.csus.edu/training/handouts
http://www.csus.edu/atcs/tools/tutorials.htm
http://www.csus.edu/atcs/tools/tutorials.htm
http://www.csus.edu/atcs/tools/accessible/
http://www.csus.edu/accessibility


 Academic Technology and Creative Services : 2008  MS Word : Creating Accessible Word Documents   21 

Online Resources 
 Accessibility Features of  Microsoft Word - Web Accessibility for All 
  http://www.cew.wisc.edu/accessibility/tutorials/MSWordFeatures.htm 
 
 Accessible Web Publishing Wizard for Microsoft Office:  Best Practices for Word 
  http://www.accessiblewizards.uiuc.edu/bp-word.php 
 

Creating Accessible PDF from MS Word – Web Accessibility Center The Ohio State 
University 

  http://www.wac.ohio-state.edu 
 
 Data and Layout Tables – University of  Wisconsin-Madison Web Accessibility 101 
  http://www.doit.wisc.edu/accessiblitiy/online-course/standards/tables.htm 
 
 Microsoft Office (Microsoft Word) 
  http://www.document-solutions.com/accessibility/AdobeAccessChapter3a9.html 
 
 NCDAE – Microsoft Word Fact sheet 
  http://ncdae.org/tools/factsheets/word.cfm?template=print 
 
 Using Markup for Word and Word Perfect – Web Accessibility for All 
  http://www.cew.wisc.edu/accessibility/tutorials/structuralmarkuptutorial.htm 
 
 WebAIM:  Microsoft Word 
  http://www.webaim.org/techniques/word/ 
 

Books 
 Microsoft Word 2007 Bible – Herb Tyson 
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http://www.cew.wisc.edu/accessibility/tutorials/structuralmarkuptutorial.htm
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